
 What are the
World Wide Web
and the Internet?

 The World Wide Web consists of millions of specially 
formatted documents (called web pages) residing on 
servers connected to the Internet.

The Internet is a vast worldwide computer network. It 
consists of the hardware that connects computers together 
and allows them to communicate with each other. Contrary 
to popular belief, the Internet is not the same thing as the 
Web! (Web pages are only one of several services available 
over the Internet, as we will discuss a little later.)

 

 

 

 What is
a server?

 A server is a powerful networked computer that stores 
information (e.g., web pages, email, shared files) and that 
desktop computers communicate with to get a service. A 
service might be getting web pages, or getting email, or 
transferring files, and so on. A server that distributes web 
pages is called a web server, a server that distributes email 
is called an email server... you get the idea. 

Server software is software that runs on a server 
computer and provides the desired service. There is web 
server software for distributing web pages, email server 
software for delivering email, file transfer software for 
transferring files, etc.

Server hardware can run more than one type of server 
software at the same time. So, for example, a server 
computer can be both a web server and an email server, 
because both types of server software are running on it. 
(Note: sometimes the word "server" refers to the 
hardware, and sometimes it refers to the software, so it 
can be confusing. If you see a reference to a "web server" 
you can assume that it means a hardware server that is 
running web server software on it.)

 

 

 



 What is
a browser?

 Web pages are viewed by a special type of software on 
your computer called a web browser. (Netscape and 
Internet Explorer are the two most popular web browsers.) 
Web pages are written in HTML (HyperText Markup 
Language), and they contain only text. (If you open a web 
page with a text editor rather than a browser, all you will 
see is text-based HTML code.) However, HTML can include 
references to graphic, sound, animation, and video files. A 
browser has the ability to get a web page from a web 
server somewhere, interpret the HTML code, fetch the 
referenced files, and then construct the page on your 
computer monitor to look as the designer intended. Be 
aware, however, that each browser can interpret the HTML 
code a little differently, so the same page displayed by 
different browsers may not look exactly the same.

 

 

 

 What is
a web site?

 The term web site refers to a collection of related web 
pages stored on a server and arranged hierarchically in 
folders. For example, the Virtual Training Help Center 
pages are collectively a web site. Below is a partial "site 
map" for the Virtual Training Help Center:

 

 

How does my
browser find the
web page I want?

Every web page has a unique address, called a URL 
(Uniform Resource Locator). A URL specifies the server on 
which the web page resides, as well as the path on that 
server to find the specific web page. An example of a URL 
is:

iit.bloomu.edu/vthc/welcome.htm

●     The above URL says that the web page is stored on 
the server named iit.bloomu.edu. (Web server 
names do not have to begin with "www", although 
most do. The only thing a computer needs to be a 
web server is to be running web server software.) 



Every server has a unique name, called a domain 
name. The Internet translates the domain name to a 
unique identifying number, called an IP address. 
With the IP address, your computer can talk to the 
remote server. (You can think of IP addresses as 
phone numbers that computers use to talk to each 
other!)

●     The URL also says that the web page's name is 
welcome.htm, and that it can be found inside the 
vthc folder on the iit.bloomu.edu server. (Web pages 
usually have .htm or .html as an extension.)

Every browser has a place where you can type the URL of 
the web site you want to see. A web page can also contain 
links to other web pages, which take you to the specified 
web page when clicked upon (without typing anything). 
Either way, once the browser is given the URL, it knows 
which server the web page resides on and where it is 
stored on that server. With both of these pieces of 
information, the browser can:

1) talk to the appropriate server

2) ask the web server software on the server 
machine to locate and send the web page to 
the browser

3) receive the web page file from the server

4) interpret the HTML contents

5) request and receive any graphic, sound or 
video files referenced by the web page 

6) construct the web page, incorporating any 
referenced files

7) display the web page

  

  What does
"client/server" mean?

 The web is an example of what is called client/server 
technology. The software on the client machine talks to 
the software on the server machine and they exchange 
information. In this case, the client software is your web 
browser, and the server software is the web server 
software running on the server machine.

 

 

  



  What is a protocol?  Every client and server software pairing communicates 
using a specific protocol, or language. For example, web 
browsers communicate with web servers using the HTTP 
protocol. 

The HTTP web protocol is just one of several protocols that 
computers use to communicate over the Internet. You can 
think of the Internet as a collection of telephones and the 
wires used to connect the phones together. When you use 
a telephone, you have to speak in a language that both 
sides understand. Languages are the equivalent of the 
various Internet protocols. Web browsers and servers talk 
to each other in Web language (HTTP); email clients and 
servers can talk to each other using the Post Office Protcol 
(POP); file transfers take place between servers and clients 
using the File Transfer Protocol (FTP); and other clients and 
servers use other languages or protocols as well.

Earlier we said that a URL looks something like this:

iit.bloomu.edu/vthc/welcome.htm

In actuality, complete URLs begin with "http://":

http://iit.bloomu.edu/vthc/welcome.htm

This tells the browser which protocol to use when 
communicating with the server. Of course, since HTTP is 
the standard protocol for the web, if you don't type the 
protocol the web browser simply assumes HTTP.

Note: There is a big advantage to having a 
standard "language" or protocol for each service 
on the Internet: client software written by one 
company can "talk" to server software written by 
another company, as long as they both "speak" 
the same protocol. For example, two very popular 
web servers are Microsoft IIS and Apache. Since 
both of these servers speak HTTP, your web 
browser doesn't care which server software it's 
talking to, or what operating system the server 
hardware is running. Conversely, the server 
doesn't care whether your client is Netscape, 
Internet Explorer, or some other browser, or 
whether you are using a Windows machine or 
Macintosh. The communication occurs and the web 
files are transferred because the same lanugage is 
being spoken.

Below is a diagram showing different client and server 
computers talking to each other. Each service (the web, 
email, etc.) has its own protocol (http, pop, etc.) that the 
client and server software use to communicate. 

As an example, look at the items in green: a file transfer 

 



client (Fetch) and a file transfer server (NcFTPd) are talking 
in the FTP language to carry out a file transfer.

 

 

 

 



 What is Dreamweaver,
and why should
I use it?

 Dreamweaver is an application that lets you create web 
pages quickly and easily, without having to know more 
than the basics of the HTML language. While working in 
the document window, you design the way your page 
should look, and Dreamweaver automatically generates 
the correct HTML (Hyper Text Mark-up Language) and 
javascript codes for web browsers to understand. You 
can even switch between seeing what the page will look 
like and the HTML code that creates it. Dreamweaver has 
very useful web site management tools to help you 
organize your web pages or work collaboratively on a 
web site.

 

  

 How do I
get started?

 To set up a new web site:

1) Make a new folder on your hard disk to hold all of 
your web files. This is called the root folder. Give the 
root folder a descriptive name (but don't use spaces!) 
This folder and the files you will put into it are called the 
local site because it's on your local hard disk, and not on 
a web server. (Yet!)

2) Launch Dreamweaver.

3) Pull down the Site menu and select New Site:

A Site Definition dialog box will appear.

4) In the Category list on the left, click Local Info:

 



The right-hand side of the Site Definition dialog box 
should now look like this:

   

   5) Enter a name for your site in the Site Name text box. 
(It's probably easiest to use the same name as the one 
you gave your root folder.)

6) Enter the path to your root folder in the Local Root 
Folder text box.

OR

Click the small folder icon to the right of the Local Root 
Folder text box. A dialog box will appear; select your 
root folder then click Select. The path will be inserted 
into the text box automatically.

7) The HTTP Address is the URL where your site will 
eventually live on web server. In the HTTP Address text 
box, enter that URL (including the "http://" part). If you 
don't know what the URL will be, leave the HTTP 
Address text box empty for now. 

Note: You will learn how to transfer your site to the web 
server in the lesson Transferring Files.

8) Select the Use Cache check box to improve the 

 



speed of link- and site-management tasks.

9) Click OK. You will see the following dialog box:

  

 

 

   10) Click OK. Dreamweaver will create your site, create 
the site cache, and open the site window:

 

  

 

 

   



  Practice  So now that you know how it's done, let's try it:

1) Create a folder for your site and name it.

2) Open Dreamweaver and open the Site Definition 
dialog box.

3) Enter the name for your site.

4) Enter the path of your local root folder.

5) If you know it, enter the site's future URL.

6) Check the Cache box to speed things up.

7) Click OK. Create the site cache, and you're done! You 
should be looking at the site window of your new web 
site.

 

 

 



How do I
create a file?

 By default, when you first launch Dreamweaver, a new 
blank file is opened. You can create and open additional 
new files by pulling down the File menu and selecting 
New:

 

If you want to create a new blank file but not open it, 
pull down the File menu and select New File:

The file will appear in the site window, where you can 
name it:

 

  



 

 How do I 
open a file that
already exists?

 To open an existing file in Dreamweaver:

1) Pull down the the File menu and select 
Open:

 

  

 

The Open File dialog box will appear: 

 



  

  

2) Be sure that Files of Type pull-down 
menu includes the file type you want, then 
make your selection.

OR

Simply double-click the file's icon in the 
site window.

Note: You can open any file with an .htm, .html, 
.cfm, or any other web file extension. It does not 
matter whether the file has been "hard coded" 
(the HTML typed in by hand) or created in 
Dreamweaver or any other HTML editor. It makes 
no difference, because the files are text-only and 
have no special format.

 

  

How do I
save a file?

 To save a file in Dreamweaver:

1) Pull down the File menu and select 
Save. The Save As dialog box will appear:

 



 

 

 

   2) Give the file a name by entering it in the 
File Name box. Dreamweaver will save 
your file as an HTML document.

 

 

How do I view
my page within
a browser?

 To view how your page looks within your default web 
browser, press the <F12> key. Your default browser will 
automatically launch and load your page. To return to 
Dreamweaver, close the browser window.

 

 

  

 Practice  Now let's make your very first web page:

1) Launch Dreamweaver.

2) Open the site you defined in the last 
lesson by pulling down the Site menu, 
selecting Open Site, and selecting your 
site from the nested menu.

3) Open a new file.

4) In the file window, type "Welcome to 
Dreamweaver."

5) Save the file, and name it "Welcome".

6) View your page in your default web 
browser.

 



Congratulations! When you're done looking at your 
page, you can close your browser's window.

In the next lesson we'll learn more about putting text 
into your web page. 

 

 



 How do I
add text?

 

As you learned in the exercise in the previous lesson, all 
you have to do to add text to your web page is click in 
the document and type. In this way, Dreamweaver is 
just like a simple word processor.

 

 

 

How do I
format text?

 

However, formatting text in HTML is a little different 
from formatting in your word processor. When you 
create a document in your word processor, you decide 
exactly how you want it to look. You have control over 
the exact font and font size that is used, how many 
spaces you want a paragraph to be indented, etc. The 
idea with web pages, however, is that the browser 
makes the final determination on exactly how a web 
page looks. As the designer of the page, you set certain 
parameters and the browser interprets them, based 
upon the user's specification. You'll learn more about 
this idea as we go. 

Several options are available under the Text menu to 
format the appearance of your text within a web page. 
Click on the Text menu to see the available options:

In this lesson we will cover the most commonly used 
formatting options. In later lessons some more advanced 
formatting will be discussed.

 



  

 What are "serif"
and "sans serif" fonts?

 

Before we learn about specifying fonts on web pages, 
first we need to add a couple of terms to our typesetting 
vocabulary: serif and sans serif. Although there are 
some exceptions, for the most part fonts fall into one of 
these two categories. A serif font is one that has serifs 
on the letters (more about that in a minute), whereas a 
sans serif font is one that does not have serifs ("sans" is 
French for "without").

OK, so what's a serif? A serif is a little ornamentation or 
bar across the ends of the strokes of a letter. It's easier 
to see than explain, so take a look at the pictures below. 
The one on the left is showing a serif font, and the red 
arrows point to the little serifs on the ends of the letters. 
The picture on the right shows a sans serif font, and the 
red arrows point to where the serifs would be, but 
aren't.

 

 

  
   Studies have shown that serif fonts are much more 

legible, and so they are usually used for extended 
lengths of text, like in paragraphs.

Sans serif fonts, on the other hand, tend to have a 
bolder, more attention-getting look, and so they are 
usually used for titles, headings, sub-heads, etc.

Professional typesetters will tend to use only two fonts 
on a page: one serif, and one sans serif. Otherwise, the 
page begins to look too busy and it can be disruptive. 
(You should usually follow this rule as well.)

 



Note: "Monospaced" fonts are fonts where each 
letter has the same width; in other words, an "i" 
takes up as much space as a "w". Monospaced 
fonts (or "mono" for short) were all that were 
available on typewriters, and on early computer 
monitors. Because of that, monospaced fonts are 
often used on web pages and documentation to 
indicate text that a person should type, or 
computer prompts. For example:

To go to the Virtual Training Help Site, enter

iit.bloomu.edu/vthc. 

If you make a mistake, you will see the following 
error message:

The page cannot be displayed.

 

 How do I
specify the font?

 

Because your web page will be transferred over the 
Internet and viewed on another computer, you don't 
know what fonts will be available to the viewer. For this 
reason, you can't pick just any old font that happens to 
be on your computer. You can do either of the following:

●     tell Dreamweaver to use whatever font is the 
default font specified by the user's browser

●     specify a group of similar fonts, and the user's 
browser will use the first one available from the 
list.

Here's how:

1) Select the text you want to format.

2) Pull down the Text menu, click Fonts, 
and select the desired item from the fly-out 
menu:

 

 



  

   ●     Select Default to use the browser's default font 
setting;

OR

●     Pick one of the available font groups;

OR

●     Choose Edit Font List to create your own font 
group. 

One of the benefits of using the pre-defined font groups 
is that the fonts listed are extremely common on both 
Windows and Macintosh computers, and so your page is 
more likely to look the way you expect it to.

Notice that at the end of each font group, it says either 
"serif", "sans serif", or "mono". What that means is that 
if none of the listed fonts are available on the viewer's 
computer, the default serif, san serif, or mono font will 
be used instead. This lets you at least specify the type of 
font, even if you can't be sure of getting the exact one 
you want.

 

 

 



 How do I change
the font size? 

In HTML, fonts are not set by point size. Instead, you 
get to choose size on a scale of one to seven. 

Here's how the different sizes look:

One
Two

Three
Four

Five
Six

Seven

If you don't specify a size, the browser will use its 
default setting.

Here's how to set the font size:

1) Select the text you want to resize.

2) Pull down the Text menu, click Size, 
and select the desired size from the fly-out 
menu:

 



 

 

There are times when you don't want to set a font to a 
specific size; instead, you want to make its size relative 
to the size of the default font. For example, if the body 
of your web page is set to the browser default, and you 
want a header to be a bit bigger, what do you set the 
size to? Since you don't know the default size, you can't 
set the header size to any specific number. In that case, 
you can use the Size Change command to set a font 
size. You can increase the size up to four steps over the 
default size by selecting either +1, +2, +3, or +4; you 
can decrease the size up to three steps below the default 
size by selecting either -1, -2, or -3. Here's how:

1) Select the text you want to resize.

2) Pull down the Text menu, click Size 
Change, and select the desired size from 
the fly-out menu:

 



Food for thought: What is the point of having the 
default font size set by the browser, rather than 
the web page designer? One good reason would be 
if the designer wanted the page to be easily 
readable by people who have difficulty seeing, but 
not ridiculously large for those who don't. The user 
could set their default font size to something very 
big, and then the web page would be displayed in 
large type for them. Can you think of any other 
reasons?

 

 How do I
set text style?

 To make your text bold, italic, and/or underlined:

1) Select the text you want to format.

2) Pull down the Text menu, click Style, 
and select the desired style from the fly-out 
menu:

 

 

 



 How do I change
the text color?

 To change the color of your text:

1) Select the text you want to color.

2) Pull down the Text menu and select 
Color. The following dialog box appears: 

 

 

 

 

   3) Select the color, then click OK.

 

 

 

 How do I indent
and "outdent" text?

A paragraph is indented when extra spaces are added to 
its left and outdented when the extra spaces to its left 
are removed. (Outdenting is the same as un-doing an 
indent.)

In the example below, the phrase "Some of the people 
who worked on this project are:" is outdented, and the 
names are indented:

Some of the people who worked on this project 
are:

Frank
Aimee
Bill

 



 

To indent a paragraph:

1) Click anywhere in the paragraph you 
want to indent.

2) Pull down the Text menu and select 
Indent.

To outdent text that has been indented: 

1) Click anywhere in the paragraph you 
want to outdent.

2) Pull down the Text menu and select 
Outdent.

 

   

 How do I
add headings?

 

Unlike a desktop word processing software, which lets 
you add various sizes and styles of headings to your 
document, you can only use six types of headings within 
a web page. Heading 1 is the largest and Heading 6 is 
the smallest. 

Here's how the different headings look:

One

Two

Three

Four

Five

Six

To add a heading to your page:

1) Click anywhere in the paragraph that 
you want to turn into a heading.

2) Pull down the Text menu, click 

 



Paragraph Format and select the desired 
heading type from the fly-out menu: 

  

 

 

   

 How do I
align text?

 

Paragraphs can be left aligned, centered or right aligned. 
To change the alignment of a paragraph:

1) Click anywhere in the paragraph.

2) Pull down the Text menu, click Align, 
and select the desired alignment from the 
fly-out menu:

 

   



 

   

 Practice

 

Let's try adding some text to a web page and doing 
some basic formatting:

1) Open a new file in Dreamweaver.

2) Type a main heading using Heading 1.

3) Type a secondary heading using Heading 
2.

4) Center the main heading on the page.

5) Color the main heading blue.

6) Type two paragraphs of text.

7) Set the font and font size of the text.

8) Italicize a sentence of your text.

9) Indent the second paragraph.

Press F12 to launch your default web browser and see 
what your page looks like. When you're done, close your 
browser.

 

 

 

 



How can I
add graphics
to my pages?

 To put a graphic on a web page, it must be in either GIF, 
JPEG, or PNG format. (See the course on Digital Images 
for detailed information about graphic formats for the 
web.)

Once you have your image in an acceptable format, it is 
easy to insert it into a web page. Just follow these steps:

1) Make sure that your blinking insertion point is located 
you want the graphic to appear. 

2) Pull down the Insert menu and select Image:

3) From the File dialog box that appears, select the 
image file you want to insert, then click Select. The 
image will be placed on your page.

Note: Right now, you can't put a graphic side-by-
side with text. You'll learn how to do that in the 
Tables lesson.

 

 

 



Practice  If you have a GIF, JPEG, or PNG image available, place it 
on the web page you have been creating. Then save the 
web page.

 

 

 

 

 



 Introduction

 

So now you have created a basic web page. That's 
great, but for anyone else to be able to see it, the page 
needs to be on a web server connected to the Internet. 
In general, web site designers do not create their web 
pages directly on a web server; instead, they use their 
local computer to design and create their website and 
then put their files on the web server so that it is 
available to be seen by web browsers.

 

 

  

How can I
put files on
a web server?

 

Sneaker Net
One way to transfer files from your computer to the web 
server is to save all your files on a floppy disk, a zip 
disk, or a CD-ROM, and then copy them to web server's 
hard drive. If you don't have physical access to the web 
server, it may be possible to send the disk to the server 
administrator and he or she will copy them to the 
correct location. Of course, this is a slower approach, 
and you may have to wait for the files to be made 
available. 

File Services
A second way to put the files onto the web server is to 
"mount" the server's hard drive as another lettered 
drive in your My Computer folder, using a username 
and password given to you by the server administrator. 
You can then drag your web files to the desired location 
on the server the same way you copy files onto any 
other disk. This is a good solution if the server is located 
on the same local network as your computer, but it's a 
poor solution for a distant server, because file services 
protocols (that is, protocols for mounting remote disks) 
can be very slow over the Internet. This approach also 
only works if the client and server computers use the 
same file services protocol, because file services 
protocols are proprietary, rather than universal.

FTP
A third, and often most efficient, way to put the files on 
the web server's hard drive is to transfer them 
electronically over the network using the file transfer 
protocol (FTP). (For a reminder about protocols, see 
Lesson 1.) FTP is very fast, and since it is a standard 
rather than proprietary protocol, it doesn't matter what 
operating system the client and server are running. 

 



As you may recall, in order to use the FTP protocol, you 
need an FTP client installed on your computer, and there 
must be an FTP server running on the server. This will 
let the two computers talk to each other and transfer 
files between them. Luckily, most servers that are 
running web server software also are running FTP server 
software. Client FTP software is easy to get, and it may 
already be installed on your machine.

Because FTP software allows you to read and write to 
the server's hard drive, you must have a username and 
password for authorized access. When you run the FTP 
client software and tell it what machine you want to 
connect to, it will prompt you for the username and 
password before it will allow you to connect. To obtain a 
username and password in order to transfer files to a 
server, see the server administrator.

 

  

Transferring
files with FTP

 

Every FTP client will look a little bit different, but the 
principle is always the same. We'll use WS_FTP, a 
common Windows FTP client, as our example client 
software. (You can download a trial copy of WS_FTP 
from www.ipswitch.com.)

To transfer files from your computer to a web server 
using WS_FTP, follow these steps:

1) Open the WS_FTP program. The screen below will 
appear: 

 

  

http://www.ipswitch.com/


 

  2) Within the Host Name box, type the domain name 
or IP address of the web server you want to connect to. 
(See Lesson 1 to review what domain names and IP 
addresses are.)

3) In the User ID box, type your username.

4) In the Password box, enter your password.

5) Click the OK button. This screen will then be 
displayed: 

 

  

  On the left side is the directory for your local hard drive. 
On the right is the directory for the remote server.

6) On the left side, navigate to the folder where your 
source html files are located.

7) On the right side, navigate to the folder into which 
you want to copy your website.

8) On the left, select the file(s) you want to transfer to 
the web server.

●     If you want to move the entire web site to the 

 



server, select the folder;

●     If you want to move just some individual files, 
select them individually. (To select multiple files 
located next to each other, click on the first file 
name in the list, then hold down the Shift button 
and click on the last file name in the list. To 
select multiple discontiguous files, hold down the 
Ctrl button and click on each file you want to 
select.)

9) Click on the right arrow in between the two columns 
to transfer your selected files from your computer (the 
left side) to the web server (the right side). 

 

  

 Practice

 

Let's get your web site established on a web server:

1) Contact your web administrator and ask her/him to:

●     

Tell you the web server host name (also called 
the DNS name).

example: iit.bloomu.edu

●     

Create a folder for your web site on the web 
server and give you the path to the folder.

example: /users/smith/

●     

Give you a username and password so you can 
access the web server.

2) Transfer your html file from your computer to the 
web server. (In an earlier lesson, you named it 
welcome.htm). 

3) Using your web browser, view your web page. The 
URL for the above example would be:

http://iit.bloomu.edu/users/smith/welcome.htm

 

 


	Local Disk
	The Web and the Internet
	Introduction
	Working with Files
	Adding Text
	Adding Graphics
	Transferring Files


